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Web Author Built-in Functionality

Server connectors for various types of file repositories

Enterprise Content Management
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Connectors available with an on-premise installation
Oxygen XML Web Author provides additional server connectors f

various other types of file repositories:

Oxygen XML Web Author
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Web Author Built-in Functionality

» Support for editing DocBook, DITA, XHTML, TEI documents and more
» Support for concurrent editing and review in any XML document

Try Web Author On-Premise
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https://www.oxygenxml.com/doc/ug-waCustom/topics/wa-framework-plugins.html
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— What can be Customized?

Sample customization use-cases:

« Integrate a File Storage Service to open/create documents

- Add editing support for custom XML formats

eu_COM(2013)0619_EN Try Web Author On-Premise
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What can be Customized?
Sample customization use-cases:

» Add custom dictionaries

Add custom term lists for the spell checker
» Add inline form controls
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Sample customization use-cases:
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What can be Customized?

» Customize the views, toolbars, menus or content completion list

» Impose validation rules and quick fixes

Try Web Author On-Premise
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» P Flower garden;
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validation ; , % Referenced resource
Most of the adia.org/, the free "http:fen.wikipedia,
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— What can be Customized?

Other sample customization use-cases:
» Integrating Concurrent Editing
« Controlling the Behavior of Drag/Drop Operations
» Customize the PDF Publishing Support
» Integrating Web Author with a User Management System


https://www.oxygenxml.com/doc/ug-waCustom/topics/webauthor-concurrent-editing-api.html
https://www.oxygenxml.com/doc/ug-waCustom/topics/customizing_ui.html#ariaid-title5
https://www.oxygenxml.com/doc/ug-waCustom/topics/wa-publishing-support.html
https://www.oxygenxml.com/doc/ug-waCustom/topics/webauthor-user-management-integration.html
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How Web Author can be Customized

- By Options

Change settings directly in the Administration Page Ul or manually add entry
elements in an options XML file

» By Frameworks

Create a package containing document type specific configuration files and
code that implement Oxygen APl and upload it using the Administration Page

» By Plugins

Create a package containing code that implements the Oxygen APl and
upload the package using the Administration Page Ul
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Customize With Options

- What options are available in Web Author?
»  Where is the options file located on the server?

- How to set an option that is common with Oxygen XML Editor/Author?
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What Options are Available in Web Author?

«  Common with the ones from Oxygen XML Editor/Author, like:
» Expand or hide the referenced content (in Author mode)
»  Show or hide comment and processing instruction nodes (in Author mode)

» Set the number of characters after which a hard line-wrapping action is
performed (in XML)

» Specific Web Author options, like:

» Security Options
» Custom Options for the Git, SharePoint or Outline Plugins


https://www.oxygenxml.com/doc/ug-waCustom/topics/customizing-options.html#customizing-options__oxygen_standalone_options_supported_by_web_author
https://www.oxygenxml.com/doc/vug-waCustom/topics/customizing-options.html#customizing-options__other_options_supported_by_web_author
https://www.oxygenxml.com/doc/versions/26.1.0/ug-waCustom/topics/customizing-options.html#customizing-options__custom_options_for_the_git_plugin
https://www.oxygenxml.com/doc/versions/26.1.0/ug-waCustom/topics/customizing-options.html#customizing-options__custom_sharepoint_options
https://www.oxygenxml.com/doc/versions/26.1.0/ug-waCustom/topics/customizing-options.html#customizing-options__section_psl_rrl_rnb
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Where is the Options File Located?

Administration Page

v Settings General Settings

General

Change tracking initial state:
License = i T = = "
ol Stored in document v <?xml version="1.8" encoding="UTF-8"2>

ugins
Frameworks B show content completion list when pressing Enter ¢sapialized version="18%.1" =ml: SIJElCE=" p!"ESEPUE"}
Connection & Show all possible elements in the content completion list
Security ® Change editors without page reload < sepializableﬂrderedﬁap >
‘ Restore Defaults
E— <entry>
Logaging
Log file: ¢String>author.show. comments< /String>

plugins\org.eclipse.wst.server.core\tmp8\logs\oxygen.log

¢<Boolean>true< /Boolean>

</entry>
Config file:
rebapps\oxygenxml-web-author\WEB-INF\log4j.properties < Jr serializableOrderedMa =g
Getions: _—V»”  </serialized>
Options file: ]

na\localhost\oxygen-xml-web-author\options\options.xml




How to Set an Option That is Common to Oxygen XML Editor?
1. Use the “Preferences” dialog from Oxygen XML Editor to set the option

Options Tools Al Document

Window Help

Preferences...

Menu Shortcut Keys...

Reset Global Options...
Import Global Options...
Export Global Options...

Web Author Customizations — Getting Started

schema

Preferences

4 Author
Cursor Navigation
> Review
> Profiling/Conditional Text
MathML
> AutoCorrect
Serialization
4 Schema Design
XSD Properties
JSON Schema Properties
4  Format
P XML
XPath
4 Content Completion
XSLT

XsD

"

X ® Editor / Edit Modes / Author / Schema-Aware

[] Schema-aware normalization, format and indent

Indent blocks-only content

Schema-Aware Editing
(Oon (off (e Custom
Schema-aware actions

Delete element tags with backspace and delete
Smart delete

Reject action when its result is invalid

Paste and Drag and Drop
Smart paste and drag and drop

[ Reject action when its result is invalid
Typing
Smart typing
Reject action when its result is invalid
Content Completion
Press Enter to show available content completion proposals
Show all possible elements in the content completion list

Allow only insertion of valid elements and attributes
21 Al

i atbribet

(®) Global Options (*) Project Options @

v

Restore Defaults

©)

| oK H Cancel H Apply ‘
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o How to Set an Option That is Common to Oxygen XML Editor?

2. Use the “Export Global Options...” action to export the options before and after

* seriglizedOptionsooml X 4 b B
serigized map entry Siring
1 <?xml version="1.0" encoding="UTF-5"32> ~ H
Options Tools Al Document Window Help 2+ <gerialized xml:space="pressrve">
Preferences... e <map
Menu Shortcut Keys... s <entry-
R Global O > 5 <5Stringxauthor.schema.aware.nc
t ti
eset Blobal ptions i <Boolean>false</Boolean>
Import Global Options... + </entry>
Export Global Options... g <entry>
a <Stringrdocument. types</3tring
10 <documentIyvpelescriptor-array,/ i
14 & famt rars i s,
< > -

Text Grid  Author
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How to Set an Option That is Common to Oxygen XML Editor?
3. Check what entry was changed, using the Diff Files Tool

Diff Files
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4. Copy the modified <entry/>in Web Author’s options.xml file

5.

Restart the Web Author server


https://www.oxygenxml.com/doc/versions/26.1/ug-editor/topics/file-comparison.html
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Frameworks (Document Types Customizations)

What is a Framework?
How to create a Framework ?
How to test a Framework?

How to upload a Framework in Web Author?
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— What is a Framework?

It provides editing support for a specific XML vocabulary (document type).

The framework can impose:
» The association rules (with a specific document type)
» The validation rules
»  The document rendering (using CSS stylesheets)
» The editing actions
» The documents templates
» The XML catalogs (used for resolving references)

» Advanced functionality through JAVA and JavaScript Oxygen API
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How to Create a Framework?

Use Oxygen XML Editor/Author to easily create or extend frameworks
- Download a kit from the website

» Request a trial license from the installation wizard


https://www.oxygenxml.com/xml_web_author/download_oxygenxml_web_author.html
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How to Create a Framework?

» Create or Extend a framework using the “Document Type” dialog

Document type X
MName: | Priority:
Description:
{4 Preferences
Type filter text Q (F) Document Type Assodation
S Storage: (@ Internal () External =
Global Discover more frameworks by using add-ons update sites
I Appearance Read more about Document Type sharing and how the storage mode affects it
Application Layout Enabled  Document type Priority
- B - Initial edit mode: | Editor spedfic
Add-ons DITA
Project Level Settings
% DITA Map Assodation rules } - i
« |[Cocmentiype Aesocatan Schema Classpath Author Templates Catalogs Transformation Validation = Extensions
Locations I it H Duplicate ” s ” Delete Namespace Root local name File name Public ID Attribute Java dass
Document Templates
Encoding Enable DTD,/XML Schema processing in document type detection
4 Editor Only for local DTDs /%ML Schemas
4  EditModes
b Text Enable DTD/XML Schema caching + 4 | i &

Grid
Global Options () Project Options @ Restore Defaults
: = o]

@ o] [[emet | [ senly



https://www.oxygenxml.com/doc/ug-editor/topics/preferences-document-type-association.html#preferences-document-type-association__extend
https://www.oxygenxml.com/doc/versions/26.1/ug-editor/topics/the-document-type-dialog.html
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How to Create a Framework?

» Create or Extend a framework using an Framework Script

script

1 <?x¥xml wversion="1.0" encoding="UIF-8"7?
* 2w l--

3

The file must be saved inside a frame

Choose a file template 4
5
8 To generate a *.framework file out of
File Edit Find Project DITAMaps Options Toals exf X , [om the contextual memn-
-—>
D N Ctrl+ M Fl Framework templates 9 vr<script xmlns="http://www.oxygenxml.c
4 Framework Extension Script 10 _\;mJ._ns'v.si::'http'Nm.wS.or\g&DDlKX
B Open.. Ctrl+0 —> —> LB 1="http://Www.0Xyg
@ Create Framework Script 12 "DITA™>
ﬁ Open URL Ctl’|+U @Eﬁtﬂ'ldﬁanewmk&ut}t 13 <name>Framework name</name>
14 <description/>
15 <priority>High</priority>
18
@ Extend Framework Script [Framework Extension Script] 17 ¥ <author>
18 + <l
[ 5ave as: :jworkspace-webapp/jeXml/samples/dita/flowers ftopics flowers/Untitled .exf - 12 Ruthor Rctions are loaded from
20 {framework_directoryl/externalk
21 {framework_directoryl/{framewor
22
® < Back Customize = I Create | | Cancel | 23 httpa://www.oxygenxml . com/doc/v
24 -—>
25w <toolbars>
26 = <toolbar>

27 <separator/>

Text  Grid Author


https://www.oxygenxml.com/doc/versions/26.1.0/ug-waCustom/topics/wa-framework-customization-script.html
https://www.oxygenxml.com/doc/versions/26.1.0/ug-waCustom/topics/wa-framework-customization-script-usecases.html

Web Author Customizations — Getting Started

How to Test a Framework?

Oxygen XML Editor/Author + Web Author Test Server Add-on

v @ inisdita - Oxygen XML Web Au X =+ - O X

« > C (@ rs%2Fflowers.ditamap8&showSave=true8istylesheet-titles=Basic ﬁ) e} @ :

Editing current document in Web A

The oXygen XML Web Author s T is now started in testing mode. Read more.

iris.dita [D:\workspace-webapp\eXmi\samples\dita\flowers\t Gwers\iris.dita] - <oXy

BV X BUBE € > @] B 7 U @@ 51>
File Edit Find Project DITA Maps Qols Al DITA Document Wind | To open iris.dita, u

e TQRkpike> -

| start Web Author Server : g v Y.

[ vt s S -
DITA Maps Manager [ e iris.dita X | Open in Browser
De-Bk - Be4 b

e of the URLs below. There is one for each network inte

Open in Browser % 2Fflowers.ditamap&showSave=true&stylesheet-titles L

&  DITAMap & .
. [Il‘lS

El
flowers.ditamap Y=

9% 2Fflowers.ditamap&showSave=true&stylesheet-titles

Contoxt: [EETm—— I S | Open in Browser % 2Fflowers.ditamap&showSave=true&stylesheet-titles ~ 1 Growing Flowers -l |7 “Metadata
o flowers.ditamap X «rmE Iris = Introduction Keywords: > & Perennial Planiq @
E=-  Growing Flowers 2
E - mntroduction ¥ Y Metadat Care and Preparation ) )

4 2 - care and Preparation

~ pruning Keywords: > #[perennial-label]Perennial | Flowers by Season »From Wikipedia, the frree encyclopedia. 4 @
- Garden Preparation Planid B i
4 - Flowers by season v = Spring Flowers bTrisdb (Flowers® (springh (iris)4)4)disa b
4 [d] - Spring Flowers N 1 "
B s > From Wikipedia, the fee encyclopedia.4 = Iris & genus4 of between 200-300 species of
5 2 snowdrop Plristb (rlowersh (spring® (iris)4)4)disab @ = Snowdrop flowering plants with showy flowers. It takes
5 [ - Summer Flowers . - .
b - Autumn Flowers [genus]genus4 of between 200-300 species of ﬁ > = Summer Flowers its name from the Greek word for a
W T WintarE v flowering plants with showv flowers. Tt takes its name ¥ v < = . - - P i P ad <
@ Showing only node hing the "no expert” con... @ Showing only content matching the "no expert” condition set. q & fatuzen Dlotaass y | Pee s Topic Title
(8 project 2§ DITA.. [7open/F.. @ AlPosi.. Text  Grid  Author |

D:\...\topics\flower: dita [DITA] Validation s ful E U+0000



https://www.oxygenxml.com/doc/ug-waCustom/topics/customizing_frameworks.html#customizing_frameworks__developing_and_testing_a_framework_using_the_weba
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How to Upload a Framework in Web Author?

Administration Page

» Go to “Administration Page”

¥ Setlings All the changes that you make in this page will be picked up by Oxygen XML Web
“" ” G \ Author after you restart the server. Read more
» Select “Frameworks
License &
“ ” i | Upload Framework
. Plugi
» Use “Upload Framework” action i
Frameworks DITA Built-in
Connection Darwin Information Typing Architecture
» Restart the Web Author server
Security

DITA Map Builtin

Darwin Information Typing Architecture

The uploaded framework should be a ZIP or JAR archive that contains exactly one folder
(with a .framework or .exf file inside and other supporting files)
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Oxygen API for Frameworks

» JavaScript API

» Used to create client-side customization

»  Some possible use-cases include:
+  Create custom actions and add them to the toolbar or contextual menu
+  Create custom form controls
+ Add custom views

« Java API

» Used to create server-side customization

» Can be used to:
- Create operations to be executed when the user invoke specific actions

+ Control advanced functionality like: filter document styles or resolve references,
using JAVA Framework Extensions (see the Extensions tab of the Document type
configuration dialog)


https://www.oxygenxml.com/doc/ug-waCustom/topics/customizing_frameworks.html#customizing_frameworks__adding_javascript_code_to_a_framework
https://www.oxygenxml.com/maven/com/oxygenxml/oxygen-webapp/26.1.0.0/jsdoc/tutorial-customaction.html
https://www.oxygenxml.com/maven/com/oxygenxml/oxygen-webapp/tutorial-formcontrol.html
https://www.oxygenxml.com/maven/com/oxygenxml/oxygen-webapp/tutorial-customview.html
https://www.oxygenxml.com/InstData/Editor/SDK/javadoc/
https://www.oxygenxml.com/doc/ug-waCustom/topics/wa-framework-java-extension.html
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Using Frameworks created for Oxygen XML Editor

» High degree of compatibility
« CSS limitations, like:
e The -oxy-=ty1e CSS property is not supported.

e The :hover pseudo-class is only available for mouse-enabled platforms.

e The focus and focus-within pseudo-classes are not supported.

» Actions compatibility limitations

If the framework contains custom Author mode operations (Java implementations of the
ro.sync.ecss.extensions.api.AuthorOperation interface), they can be enabled to be used by the Oxygen XML Web Author using the

ro.sync.ecss.extensions.api.Webapplompatible annotation.

Sometimes this is just a matter of annotating your custom Java class. In other cases (for example, when the authoroperation is

used to show a custom Java Swing dialog box), it has to be re-implemented in JavaScript.


https://www.oxygenxml.com/doc/versions/26.1.0/ug-waCustom/topics/webapp_css_limitations.html
https://www.oxygenxml.com/doc/versions/26.1.0/ug-waCustom/topics/wa-migrate-frameworks.html#wa-migrate-frameworks__section_k2h_qtx_jjb
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Write Java Unit Tests for a Framework

Sample Java Unit Test For a Framework:

https://github.com/oxygenxml-incubator/oxygen-sample-frameworks/tree/main/sample-java-unit-test

46
47
48
49
50
51
52
53
54
55
56
57
58
59
60

@Test
v public void testRootElementStyles() throws Exception {
File testFile = new File("src/test/resources/sample-doc.xml");

AuthorDocumentModel authorDocumentModel = createAuthorDocumentModel(testFile);

AuthorElement rootElement =

authorDocumentModel. getAuthorDocumentController().getAuthorDocumenthode().getRootElement();
Styles rootElementStyles =

authorDocumentModel. getAuthorAccess().getEditorAccess().getStyles(rootElement);
Color roctColor = rootElementStyles.getColor();

Color redColor = new Color(255, @, 8);
boolean isRedColorOnRoot = rootColor.equals(redColor);

assertTrue(isRedColorOnRoot);


https://github.com/oxygenxml-incubator/oxygen-sample-frameworks/tree/main/sample-java-unit-test
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Sample Frameworks Customizations

https://github.com/oxygenxml-incubator/oxygen-sample-frameworks

Using the frameworks

To use the frameworks in Oxygen XML Web Author, you should:

1. Make sure you have Oxygen XML Web Author version 24 or later.

2. Download the entire repository

3. Create an archive with just the folder that contains the desired framework
4. Go to the Web Author Administration Page

5. In the Frameworks section, click Upload Framework and choose the archive made at step 2.


https://github.com/oxygenxml-incubator/oxygen-sample-frameworks
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Customize With Plugins

»  What is a Plugin?

» JavaScript Plugins

» JAVA Extension Types for Plugins
» How to upload a Plugin

»  Sample Plugins
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What is a Plugin

A package containing files that adds extra functionality to Web Author using a
series of application-provided extension points

Can contain client-side customization code that uses the JavaScript API

Provides multiple JAVA extensions types that can be used for specific
customizations
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JavaScript Plugins

https://www.oxygenxml.com/maven/com/oxygenxml/oxygen-webapp/26.1.0.0/jsdoc

Tutorials~

Implementing a Custom Action

Customizing the Side Views

Presenting a Dialog to the User

Implementing a Custom Form Control

Customising the Editor using Loading Options

Madifying the Document

Retrieving Information About the Current Document by Invoking Java Operations from JavaScript Code
How to Remove a Toolbar Button

Show Table Properties action for custom table

Using a Custom URL Chooser


https://www.oxygenxml.com/maven/com/oxygenxml/oxygen-webapp/26.1.0.0/jsdoc
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JAVA Extension Types for Plugins

Samples of JAVA Extension Types:

URLStreamHandler (integrate Web Author with an XML database or CMS)
WorkspaceAccess (execute code when the application is started)

WebappServlet (provide an implementation of a servlet-like interface)
WebappServletFilter (provide an implementation of a javax.servlet.Filter)
AuthorStylesheet (add a stylesheet to be used for rendering all XML documents)
WebappCSSResource (specify a CSS stylesheet to be used for styling the interface



Web Author Customizations — Getting Started

How to Upload a Plugin in Web Author

» Go to “Administration Page” and select “Plugins”

» Use “Upload Plugin” action and the Web Author server

Administration Page

~  Settings All the changes that you make in this page will be picked up by Oxygen XML Web
General Author after you restart the server. Read more
License
Upload Plugin
Plugins
Frameworks Discover More Plugins...
C ti
Sl WebDAV Connector v26.0 Enabled
Security

Plugin that enables oXygen XML Web Author to connect to a server with
WebDAVY support.

Q Canfigure View License
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Sample Plugins

https://github.com/oxygenxml/web-author-sample-plugins
https://github.com/oxygenxml/web-author-webdav-plugin
https://github.com/oxygenxml/web-author-rest-plugin


https://github.com/oxygenxml/web-author-sample-plugins
https://github.com/oxygenxml/web-author-webdav-plugin
https://github.com/oxygenxml/web-author-rest-plugin
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Documentation

» Customization Guide:
https://www.oxygenxml.com/doc/ug-waCustom/

» JavaScript APl Documentation:
https://www.oxygenxml.com/maven/com/oxygenxml/oxygen-webapp/26.1.0.0/jsdoc

« Java APl Documentation:
https://www.oxygenxml.com/InstData/Editor/SDK/javadoc/


https://www.oxygenxml.com/doc/ug-waCustom/
https://www.oxygenxml.com/maven/com/oxygenxml/oxygen-webapp/26.1.0.0/jsdoc
https://www.oxygenxml.com/InstData/Editor/SDK/javadoc/
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Troubleshooting Deployment Errors

Browser logs

Check the Developer Tools in your browser, Console tab

Server logs

Check the Administration Page - General Settings - Options - Logging

Locate the log file and check it for errors

Locate log configuration file (Administration Page - General Settings - Options)
and set the debug level to JAVA packages logging, like:

logd]j.
logdj.
log4dj.

logdj.

category.
category.
category.

category.

org.apache
org.apache
org.apache

org.apache

.http.
.http.
JEEp.

.http.

impl.conn=debug
impl.client=debug
client=debug

headers=debug


https://www.oxygenxml.com/doc/versions/topics/webapp-troubleshooting.html?hl=troubleshooting%2Cdeployment%2Cerrors#webapp-troubleshooting__dlentry_wqr_dgk_54b
https://www.oxygenxml.com/doc/ug-waCustom/topics/web-author-logs.html#web-author-logs

Web Author Customizations — Getting Started

Technical Support

Forum
https://www.oxygenxml.com/forum/oxygen-xml-web-author/

Contact the Support Team using the form on our website

https://www.oxygenxml.com/techSupport.html
here you can add up to 200MB attachments

Email
support@oxygenxml.com


https://www.oxygenxml.com/forum/oxygen-xml-web-author/
https://www.oxygenxml.com/techSupport.html
mailto:support@oxygenxml.com
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